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This resource has been developed to assist teachers in NSW Department of Education schools to create learning that is contextualised to their classroom. It can be used as a basis for the teacher’s own program, assessment, or scope and sequence, or be used as an example of how the new curriculum could be implemented. The resource has suggested timeframes that may need to be adjusted by the teacher to meet the needs of their students.


[bookmark: _Toc112681289][bookmark: _Toc184214123]Overview
Description: this teaching support resource addresses Thinking and working geographically, providing examples of how students can engage with the the geographical tool of data and graphs. The lessons in this resource are designed to allow students to build understanding of this geographical tool through a range learning activities and can be applied where appropriate across Geography 7–10.
Duration: this learning sequence is designed to be completed in approximately 3 hours.
[bookmark: _Toc184214124]Outcomes
A student:
GE4-TAP-01 selects and uses geographical tools to acquire and process geographical information
GE5-TAP-01 applies and evaluates a range of geographical tools to acquire and process geographical information
Geography 7–10 Syllabus © NSW Education Standards Authority (NESA) for and on behalf of the Crown in right of the State of New South Wales, 2024.


[bookmark: _Toc184214125]Learning sequence 1 – guide to teaching climate graphs
Note: the guide to teaching climate graphs is designed to be used as a support resource for teachers addressing Thinking and working geographically. This resource is not guiding teaching and learning of a specific topic content in the Geography 7–10 Syllabus; rather, it provides resources and strategies that can be applied contextually at any point across the stages.
[bookmark: _Toc184214126]Syllabus content
Data and graphs are to be integrated into Stage 4 and Stage 5 as appropriate: sector graphs, climate graphs, population profiles, scatter plots, bubble charts, line, column and bar graphs.
Quantitative data can be recorded and represented using tally marks and charts, datasets, data tables and graphs.
[bookmark: _Toc184214127]Learning intentions and success criteria
Note: these learning intentions and success criteria are general and should be contextualised to suit your school and students’ needs.
[bookmark: _Toc171683214][bookmark: _Hlk169170778][bookmark: _Toc184214128]Learning intention
Students learn about:
the purpose and characteristics of climate graphs.
[bookmark: _Toc171683215][bookmark: _Hlk169170792][bookmark: _Toc184214129]Success criteria
Students will be able to:
interpret a climate graph to compare rainfall and temperature patterns
construct a climate graph.

[bookmark: _Toc138328459][bookmark: _Toc184214130]What is a climate graph?
A climate graph shows the average monthly temperatures and precipitation for a place over a year. A climate table contains average monthly temperature and precipitation data for a place over the year. Climate graphs are drawn from the data in a climate table.
[bookmark: _Toc138328460][bookmark: _Toc184214131]Features of a climate graph
Note: knowledge of Common graphs, particularly line and column graphs, and the statistical terms ‘sum’ and ‘mean’ are recommended prior learning.
A climate graph consists of 2 graphs – a line graph and a column graph. The line graph illustrates temperature (°C) and the column graph illustrates precipitation (mm) for each month. Figure 1 illustrates the key features of climate graphs and climate tables.
[bookmark: _Ref173840639]Figure 1 – features of climatic graphs and climatic tables
[image: Features of climatic graphs and climatic tables.]
Watch Climatic graphs (2:14) and review Figure 1 to answer the questions below.
Which town in Australia is represented by this table and graph?
What is the latitude and longitude of this town?
Why would we want to know the latitude and longitude of this town?
Which hemisphere is the town located in?
Which unit of measurement is used to show the temperatures?
Which unit of measurement is used to show the precipitation (rainfall)?
What is the mean temperature in the town during April?
In which month did 109 mm of rain fall?
[bookmark: _Toc138328461][bookmark: _Toc184214132]Interpreting climate graphs
Climate graphs give information about the temperature, precipitation and location of a place. We can use this to learn more about the seasons and local environment. People interpret climate graphs when making a range of decisions including what crops or plants they will grow and where they want to live or travel.
The highest precipitation will be shown by the highest column in the graph or the largest precipitation figure in the table.
The lowest precipitation will be shown by the lowest column in the graph or the smallest precipitation figure in the table.
A grouping together of several high columns will show a distinct wet season and a group of low columns will show a distinct dry season.
To find out the total precipitation for the year, add up all 12 precipitation figures from the table.
The maximum temperature is shown by the highest point on the line graph, or the highest temperature value in the table.
The minimum temperature is shown by the lowest point in the line graph, or the lowest temperature shown in the table.
The temperature range is the difference between the highest and lowest temperature. This is found by subtracting the minimum temperature from the highest temperature.
[bookmark: _Ref173840688]Figure 2 – Darwin climatic graph
[image: Table above chart with location data: Darwin NT Australia, 12°28'S, 130°51'E, temperature range 4°C, total precipitation not given. Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. Line chart fairly flat with a small dip in February, slightly lower dip from June to August, and a small dip in December. Peaks in March–April and October–November. Column graph has high values in January, February, March and December, moderate in April, October and November, and very low values May–September. ]
Data adapted from Australian Bureau of Meteorology, Climate statistics for Australian locations: Darwin Airport and reproduced with the permission of the Bureau of Meteorology.
Review Figure 2 and answer the following questions:
Which month has the highest precipitation?
How much rain fell during this month?
Which month had the lowest precipitation?
What is the total annual (yearly) rainfall for the year?
Name the months in the wetter season.
Name the months in the drier season.


Answers:
· January; 442 mm (plus or minus 3 mm acceptable).
· June, July and August.
· 1873 mm (plus or minus 20 mm acceptable).
· January, February, March, November and December; April, May, June, July, August, September and October.
[bookmark: _Ref173840697]Figure 3 – Tokyo climatic graph
[image: Table above chart with location data: Tokyo, Japan, 35°39'N, 139°50'E, temperature range not given, total precipitation 1600mm. Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. Line chart in a upside-down U-shape with a high peak in August and low points in January and December. Column graph has lower values in January, February and December, moderate values in March, April, May, July, August and November and higher values in June, September and October.]
Data sourced from Japan Meteorological Agency website.
Review Figure 3 and answer the following questions.
What is Tokyo’s maximum temperature?
In what month does this occur?
What is Tokyo’s minimum temperature?
In which month does this occur?
What is the annual temperature range in Tokyo?
Answers:
· 30°
· August
· 5°C
· January
· 25°C.
Places located in the northern hemisphere will show a temperature line dip during December, January and February. Places located in the southern hemisphere will show a temperature dip during June, July and August. A temperature line which is almost flat shows that this place is close to the equator. Places close to the equator have a small temperature range. A temperature line which has a large dip in it shows a place that is a long way from the equator or a long way inland. These places have large temperature ranges.
[bookmark: _Ref173840711]Figure 4 – climatic graph examples
[image: Two climatic graphs: City A and City B. City A temperature line and precipitation columns are decreasing from January to July and increasing from July to December. City B temperature line is increasing from January to July and decreasing from July to December. The precipitation columns increase from January to June, with a small dip in May, and decrease from June to December.]
Data adapted from Australian Bureau of Meteorology.
Review Figure 4 to answer the following questions.
Which city is located in the northern hemisphere?
Is City A close to the Equator? Explain your answer.
Answers:
· City B is located in the northern hemisphere.
· No, because there is a temperature variation.


[bookmark: _Toc184214133]Teaching seasons through climate graphs
Climate graphs are useful for identifying seasons at a location. Seasons can be determined by temperature data.
Summer: shown by a peak on the temperature line.
Autumn: shown by a downturn on the temperature line.
Winter: shown by a trough on the temperature line.
Spring: shown by an upturn on the temperature line.
Seasons can also be determined by precipitation data.
Wet: a series of months with high precipitation columns.
Dry: a series of months with low precipitation columns.
[bookmark: _Ref173840723]Figure 5 – climatic graphs for Troughton Island and Gunnedah
[image: Troughton Island climatic graph has a temperature line with 5°C range. The line is fairly flat with a slight downtrend from April to July and uptrend from July to November. Precipitation columns are highest in January, February, March and December with very low columns in other months. Total precipitation is 817mm. Gunnedah temperature line is decreasing from January to July and increasing from July to December. The precipitation columns are low with little change across the year.]
Data adapted from Australian Bureau of Meteorology, Climate statistics for Australian locations: Troughton Island and Gunnedah have been reproduced with the permission of the Bureau of Meteorology.
Review Figure 5 and answer the following questions.
During which 3 months is winter in Troughton Island?
During which 3 months is autumn in Gunnedah?
When is the wet season in Troughton Island? Justify your response.
Answers:
· Troughton Island – June, July and August
· Gunnedah – March, April and May
· answers will vary.
Seasons differ across cultures and environments. The Cree, one of the largest First Nations in Canada, observe 6 seasons each year: Pipon (winter), Sikwan (spring), Mitoskamin (when the ice breaks up), Nipin (summer), takwākin (fall), and mikiskāw (lakes freeze). India has also observed 6 seasons, called ‘Ritu’, since ancient times. Figure 6 shows these seasons annotated on a climatic graph of New Delhi.
[bookmark: _Ref173840733]Figure 6 – annotated climatic graph of New Delhi
[image: Climatic graph of New Delhi, India, with annotations showing the seasons shishir ritu, vasant ritu, grishma ritu, varsha ritu, sharad ritu and hemant ritu.]
Data adapted from New Delhi Climate (India) © Climate-Data.org.
In Australia, Aboriginal and Torres Strait Islander Nations have distinct seasons based on climate and the environment. Visit Indigenous Weather Knowledge and explore the seasons of the Nations in Figure 7 and Figure 8. Using Figure 6 as an example, annotate the climatic graphs with the season names, months and key climatic and environmental management features. 
[bookmark: _Ref173840770]Figure 7 – climatic graph for Guyra NSW located in the Banbai nation
[image: Table above chart with location data: Guyra, NSW, Australia, 30°13'S, 151°40'E, temperature range 13°C, total precipitation 906mm. Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. ]
Data adapted from Australian Bureau of Meteorology, Climate statistics for Australian locations: Guyra Hospital and reproduced with the permission of the Bureau of Meteorology.


[bookmark: _Ref173840786]Figure 8 – climatic graph for Sydney NSW located in the D’harawal nation
[image: Table above chart with location data: Sydney, NSW Australia, 33°52'S, 151°13'E, temperature range 10°C, total precipitation 1211mm. Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. ]
Data from Indigenous Weather Knowledge and Australian Bureau of Meteorology, Climate statistics for Australian locations: Sydney and reproduced with the permission of the Bureau of Meteorology.

[bookmark: _Toc138328463][bookmark: _Toc184214134]Drawing a climate graph
Note: students will require graph paper, a pencil, ruler, eraser, black pen, blue pen and red pen to construct a climate graph. A climate graph template is provided in Appendix 1.
Draw a climate graph of the data from Table 1 below, using these steps:
Look carefully at the climate table and decide the size of your vertical and horizontal axis for the graph.
Rule up the horizontal axis so that there are 12 spaces across it. Write the letter for each month.
Rule up the temperature scale and the precipitation scale. Write in the temperature and precipitation figures. Label each axis.
Note: axis ticks (the increment marks on the axis) must be evenly spaced with a consistent change in value. Standard tick increment values are 5°C for the temperature axis and 50 mm for the precipitation axis, however, any values can be used.
Begin plotting the temperature information from the table. Mark temperature values with a dot in the middle of the column for their corresponding month in line with the value on the temperature axis. Join the dots in a straight line.
Use a ruler to draw the column graph for precipitation. The columns in a climate graph touch each other. Start with drawing the column for January and repeat until each month is complete.
[bookmark: _Ref173840921]Table 1 – climate table for Ballina, NSW 
	Month
	J
	F
	M
	A
	M
	J
	J
	A
	S
	O
	N
	D

	Temperature (°C)
	24
	24
	23
	20
	17
	15
	14
	15
	18
	20
	21
	23

	Precipitation (mm)
	167
	225
	232
	183
	159
	195
	109
	77
	69
	106
	115
	147


Data modified from Climate statistics for Australian locations: Ballina and rounded to nearest whole number.
Use the marking rubric and Figure 9 to conduct a peer assessment of your climate graphs.
Table 2 – peer marking rubric for climate graphs
	Criteria
	Yes
	No
	Comments

	Title is clear and concise
	☐	☐	

	Axis is labelled correctly
	☐	☐	

	Climate graph is presented
	☐	☐	

	Scale of measurement on axis is appropriate
	☐	☐	

	Spelling is correct
	☐	☐	

	Climate graph is neatly presented
	☐	☐	


[bookmark: _Ref173840847]Figure 9 – Ballina, NSW climatic graph
[image: Table above chart with location data: Ballina, Australia, 28°50'S, 153°33'E, temperature range 10°C, total precipitation 1784mm. Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. ]
[bookmark: _Toc138328464]Data adapted from Australian Bureau of Meteorology, Climate statistics for Australian locations: Ballina and reproduced with the permission of the Bureau of Meteorology.

[bookmark: _Toc184214135]Constructing a climate graph in Excel
Note: teachers need to provide students with climate data. Bureau of Meteorology and Climate data for cities worldwide may provide data relevant to the context of your school.
[bookmark: _Toc184214136]Create the data table
Open a new Excel workbook. Enter the following headers in column A:
location
latitude
longitude
temperature range (°C)
total precipitation (mm).
[bookmark: _Ref173840812]Figure 10 – Excel screenshot of column A data
[image: A screenshot of an excel chart illustrating titles to be filled into fields 1 through to 5. ]
Note: use the Symbols icon in the Insert menu to insert the degrees symbol (°).
Enter the data for each header in column B. Type the following formulas to calculate temperature range and total precipitation:
Cell B4: =MAX(E3:P3)-MIN(E3:P3)
Cell B5: =SUM(E2:P2)
Figure 11 – Excel screenshot column B data
[image: A screenshot of an excel chart illustrating titles to be filled into fields 1 through to 5 and row B to be completed with Ballina NSW Australia, 28°50'S and 153°33'E, Temperature range 0 and total precipitation 0. ]
Note: the formulas will result in 0 until the climate data is entered.
Enter the climate data in a table across columns A to M with months in the header row starting from cell A7. Enter precipitation data in the second row starting from cell A8 and mean temperature data in the third row starting from cell A9.
Figure 12 – Excel screenshot of location, precipitation and temperature data
[image: A screenshot of an excel chart illustrating table to be completed for precipitation (mm) for the 12 months of the year and temperature. ]
[bookmark: _Toc184214137]Create the combination chart
Select the climate data in cells A7:M9.
Figure 13 – Excel screenshot of precipitation and temperature data
[image: A screenshot of an excel chart illustrating selection of climatic data in cells A7:M9. ]
Open the Insert menu. Select the Combo icon in the charts submenu. Select the Clustered Column – Line on Secondary Axis icon.
Figure 14 – Excel screenshot of the icon for charts in Excel
[image: A screenshot of a computer illustrating selection of clustered column graph. ]
Note: if the combo icon is not visible, select the Expand icon for charts [image: Icon showing arrow.] to see all charts.
A chart will be created in the worksheet.
Figure 15 – Excel screenshot of basic climatic graph
[image: A screenshot of an excel cluster column graph. ]
[bookmark: _Toc184214138]Format the chart
Double click a precipitation column in the chart to open the Format data series menu. Select the chart icon and change series options to plot series on the secondary axis.
Note: repeat this step if the right axis disappears. The final chart should have the temperature on the left axis and the precipitation on the right.
Change the gap width to 0%.
Figure 16 – Excel screenshot of the Format Data Series menu
[image: A screenshot of tools used in excel to change the gap width to 0%. ]
Figure 17 – Excel screenshot of climatic graph
[image: A screenshot of an excel chart illustrating cluster graph as a climatic graph. ]
Select the green plus symbol next to the chart to change the chart elements. Turn on Axis Titles. Turn off Legend. Select the arrow next to gridlines. Turn off Primary Major Horizontal. Turn on Primary Major Vertical. Select anywhere in the worksheet to close the chart elements box.
Figure 18 – Excel screenshot of chart elements
[image: A screenshot of instructions using Excel to turn axis chart off and on to illustrate set data identified. ]
Select the chart title. Select the formula bar at the top of the worksheet and type ‘Climate Graph’.
Figure 19 – Excel screenshot to find chart title
[image: A screenshot of an excel chart title for altering title in chart. ]
Figure 20 – Excel screenshot of axis titles
[image: A screenshot of an Excel chart illustrating a climatic chart.  ]
Select the left axis title. Select the formula bar. Type: =A9. Press enter.
Figure 21 – Excel screenshot of left axis
[image: A screenshot illustrating how to change the formula bar by typing in =A9.]
Figure 22 – Excel screenshot climatic graph temperature labelled
[image: A screenshot of an Excel chart illustrating a climatic graph. ]
Select the right axis title. Select the formula bar. Type: =A8. Press enter on your keyboard. Select the horizontal axis title. Select the formula bar. Type: =A7. Press enter on your keyboard.
Figure 23 – Excel screenshot labelled climatic graph
[image: A screenshot of an Excel chart illustrating a climatic graph. ]
Double click on the left axis values to open the Format axis menu. Select the chart icon and expand axis options. Set the following values:
bounds
minimum: −20.0
maximum: 40.0
units
major: 5.0
minor: 1.0
horizontal axis crosses axis value: −20.0.
Expand tick marks. Set major type as Outside.
Figure 24 – Excel screenshot format axis
[image: A screenshot of Excel tools used to format axis. Highlighted green axis options where parameters are selected. ]
Select the right axis. Select the chart icon and expand axis options. Set the following values:
bounds
minimum: 0.0
maximum: 600.0
units
major: 50.0
minor: 10.0
Expand tick marks. Set major type to Outside.
Figure 25 – Excel screenshot of formatting axis outside
[image: A screenshot of Excel tools used to format axis. Highlighted green axis options where parameters are selected. ]
Select the horizontal axis. Select the chart icon and expand tick marks. Set major type as Outside.
Figure 26 – Excel screenshot formatting axis interval marks
[image: A screenshot of Excel tools used to format axis. Highlighted green axis options where parameters are selected. ]
Figure 27 – Excel screenshot of climatic graph
[image: A screenshot of a climatic graph showing axis details for temperature and precipitation. ]
Double click on a precipitation column. Select the paint bucket icon to change the colour and add a border to the columns. This is optional. Blue is recommended for precipitation columns.
Figure 28 – Excel screenshot of Format Data Series
[image: A screenshot of Excel tools used to format axis. Highlighted green fill options where parameters are selected. ]
Double click on a temperature column. Select the paint bucket icon to change the colour of the line. This is optional. Red is recommended for temperature columns. Select the marker sub-menu. Expand marker options. Select automatic. Select the colour for the marker fill and border.
Figure 29 – Excel screenshot of marker and fill series
[image: A screenshot of Excel tools used to format axis. Highlighted green fill options where parameters are selected. ]
Figure 30 – Excel screenshot of climatic graph
[image: Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. ]
[bookmark: _Toc184214139]Include additional information
Increase the chart height by dragging the bottom middle white dot downwards. Select a blank space within the chart plot area. Drag the top middle white dot for the chart plot area downwards to create a white space between the chart title and the chart.
Figure 31 – Excel screenshot of chart title
[image: Climatic graph with temperature shown as a line chart and precipitation as a column chart from months January–December. ]
Select cells A1:B5.
Figure 32 – Excel screenshot of cells A1:B5
[image: A screenshot of an Excel chart.]
Press Ctrl+C on your keyboard to copy the cells. Place the cursor in cell A11. Select the down arrow on the Paste button in the Home tab. Select the clipboard icon with the link and picture.
Figure 33 – Excel screenshot of the copy and paste graph images
[image: Screenshot of Excel home, with copy and paste options. ]
Select the picture. Press Ctrl+C on your keyboard. Select the open space on the chart. Press Ctrl+V on your keyboard to paste the picture in the chart. Move and resize if needed.
Figure 34 – climatic graph Ballina, NSW
[image: Completed climatic graph for Ballina NSW. Location information in a table at the top of the climatic graph, temperature range calculated by maximum mean temperature minus minimum mean temperature, total precipitation as the sum of all precipitation over the 12 months, line graph represents temperature, column graph represents precipitation, left axis has temperature values, right axis has precipitation values.]
Data adapted from Australian Bureau of Meteorology, Climate statistics for Australian locations: Ballina and reproduced with the permission of the Bureau of Meteorology.

[bookmark: _Appendix][bookmark: _Toc184214140][bookmark: _Hlk122451129]Appendix 1 – climate graph template
[image: Blank climate graph template for students to complete.]
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